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Abstract: Background and aim: Collagen fibers are the main component of atherosclerotic lesions and should there-
fore be used as an index to evaluate plaque stability. Although Masson’s trichrome stainis usually employed to 
identify the extracellular matrix, collagen fibers identified using this staining method are difficult to analyze because 
the three main colors often co-localize in same area within the atherosclerotic lesion. To solve this problem, we 
presented a convenient method for quantification of the collagen fibers in atherosclerotic lesions with Masson’s 
trichrome stain. Methods: This method is based on the open-resource image software ImageJ and an associated 
color deconvolution plugin. Original images of atherosclerotic lesions were converted into RGB images, and these 
images were deconvolved by ImageJ using the color deconvolution plugin. Results: The resulting monochromatic 
image obtained showed collagen fibers in maximal separation from background tissues. To calculate the area of the 
green component, collagen fibers were quantified in an accurate and efficient manner. Conclusions: Because of the 
simplicity and accuracy of this method, it may be widely applied for studying atherosclerosis in humans or various 
animal models.
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Introduction

The primary components of an atherosclerotic 
lesion are extracellular matrix proteins, includ-
ing collagen and elastin, which account for 
more than 60% of the lesion [1]. Collagen 
degeneration results in atherosclerotic plaque 
vulnerability; thus, the collagen content is con-
sidered an indicator of plaque stability [2]. 
Notably, Shiomi et al. introduced the morpho-
metric ‘vulnerability index’, which is the ratio of 
macrophages and extracellular lipid deposits to 
smooth muscle cells (SMCs) and collagen fibers 
in the atherosclerotic plaque [3]. This index is 
usually employed to evaluate the degree of 
plaque destabilization in animal models. Con- 
sidering that collagen fibers are responsible for 
the mechanical strength of the plaque, the 
number of collagen fibers determines the 
mechanical properties of the plaque [4]. Unlike 
the identification of macrophages and SMCs in 

an atherosclerotic lesion, immunohistochemi-
cal quantification of collagen fibers in an ath-
erosclerotic lesion is not practical because at 
least four distinct types of collagen have been 
found. For this reason, numerous studies have 
used Masson’s trichrome stain to identify the 
collagen fibers regardless of collagen type [5, 
6]. However, with this three-color staining, col-
ors usually co-localize on the surface of tissue 
and strongly interfere with the identification of 
a specific component within the tissue [7]. If 
the quantification of the collagen fibers relies 
on the calculation of specific staining based on 
visual inspection, this procedure could cause a 
considerable number of errors. Therefore, to 
overcome this obstacle, we developed a conve-
nient method to quantify collagen fibers using 
Masson’s trichrome stain and the open-
resource image software ImageJ with its color 
deconvolution plugin.
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Materials and methods

Sample preparation

Japanese white rabbits were fed with a high-
cholesterol diet (HCD; containing 0.3% choles-
terol and 3% corn oil) for 16 weeks to develop 
atherosclerosis as previously described [8]. 
After the rabbits were euthanized, the aortas 
were isolated and then fixed with 4% formalde-
hyde solution. For histological analysis, the aor-
tic arch of each rabbit was cut into 10 cross 
sections (3 μm) as previously described [9]. 
Frozen cross sections of the aortic root in apoE 
deficient mice were kindly gifted by Dr. Hua 
Guan (Research Institute of Atherosclerotic Di- 
sease, Xi’an Jiaotong University Cardiovascular 
Research Center). The sections were stained 
with Masson’s trichrome stain.

Histological staining

Masson’s trichrome stain was performed acc- 
ording to a standard protocol [10]. Briefly, sec-
tions were stained with Hansen’s iron hema-
toxylin for 5 min. After the sections were wash- 
ed under running tap water for 5 min, they were 
stained with Biebrich scarlet-acid fuchsin for 
10 min. After the sections were further rinsed 

in distilled water, they were treated with phos-
phomolybdic acid for 10 min. Then, sections 
were stained with light green instead of Methyl 
Blue for 10 min to avoid any possible confusion 
between blue nuclear staining and collagen 
staining. In Masson’s trichrome stain, stained 
components were identified as the following: 
nuclei were stained black or blue; cytoplasm, 
muscle, and erythrocytes were stained red; and 
collagen fibers were stained green.

Quantification of collagen fibers by ImageJ

As shown in Figure 1, four steps are considered 
necessary for quantifying collagen fibers: instal-
lation of the software and plugin, setting the 
scale, deconvolution of the color images and 
quantif﻿﻿ication of the collagen fibers. The algo-
rithm described below was used in conjunction 
with version 1.8 of ImageJ.

Image processing

Image acquisition is a prerequisite for further 
analysis, and four steps are required as previ-
ously reported [11]. First, all images should be 
acquired under identical conditions. To avoid a 
short range on the grayscale (0-255), the auto-
matic exposure and white balance should be 
turned off. Then, the blank part of images 
should be adjusted to white, and the false-pos-
itive staining should be excluded from images. 
Last, all images should be digitized and stored 
in an uncompressed tagged image file format 
(tiff) with 24-bit RGB and 640 × 480 pixel 
resolution.

Scale setting

As shown in Figure 2A, the scale bar was mea-
sured by the “Straight” line tool in the “Analyze” 
menu, which allowed us to set the length of 
scale bar in the “Known Distance” box and set 
the unit (μm) in the “Unit of Length” box under 
the “Set scale” dialogue box.

Deconvolution of color images and identifica-
tion of collagen fibers

Separation via color deconvolution provides a 
means of separating collagen fibers from the 
overlapping regions. The basis of this method is 
to separate the component stains by perform-
ing an orthonormal transformation of the 
image’s RGB information [12]. During color 
image deconvolution, the images were opened, 

Figure 1. Flow chart 
of the experimental 
procedure. 
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Figure 2. Procedure for processing images with ImageJ. Scale setting (A): 1) The scale bar was measured using the “Straight” line tool and 2) entered into the “Analy-
sis” menu. 3) The length of scale bar was entered into the “Known Distance” box, and the unit (μm) was set in the “Unit of Length” box. (B) Color deconvolution: 1) 
The image was converted to an RGB color space and 2) processed using the “Color Deconvolution” plugin.
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and the following steps were applied. First, the 
input images were converted to RGB images by 

entering the “Image” menu, clicking on the 
“Type” box, and choosing the “RGB Color” com-

Figure 3. Images of atherosclerotic lesions processed by color deconvolution. The original RGB imagesof atheroscle-
rotic lesions from rabbit (Light Green, upper), mouse (Light Green, middle) and rabbit (Methyl Blue, lower) were split 
into their red, blue and green components. 

Figure 4. Quantification of the green component using ImageJ software. The threshold (A) was set to a constant 
value (B) for the green component. The results were shown as the area and integrated intensity (C).
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mand to convert the images (Figure 2B). 
Second, images with Masson’s trichrome stain 
were processed using the “Color Deconvolu- 
tion” plugin by clicking “Color Deconvolution” in 
the “Plugins” menu to deconvolve the images 
into their red, blue and green components; the 
green component was identified as the colla-
gen fibers (Figures 2B, 3).

Quantification of collagen fibers

The area of the green collagen fibers was mea-
sured after we entered the “Image” menu, click- 
ed on the “Adjust” box, and isolated the green 
area of collagen fibers using the “Threshold” 
tool. The threshold was manually adjusted until 
the entire green area was highlighted in red 
(Figure 4). Then, measurement of the threshold 
area was performed as follows: we entered the 
set measurement dialog under the “Analyze” 
menu, and after we checked the “Area”, 
“Integrated Intensity” and “Limit to Threshold”, 
when we clicked the “Measurement” button 
under the “Analyze” menu, the results were 
presented in the “Results” window (Figure 4). 
Finally, area-based analysis was used to extract 
and quantify the regions of interest (ROIs) from 
the image. This analysis allowed the perfor-
mance of the algorithm to be evaluated. To 
quantify the collagen fibers in the ROI (i.e., the 
atherosclerotic plaque), the “ROI manager” 
was chosen in the “Tools” box under the 
“Analyze” menu, and the region containing the 

atherosclerotic plaque was identified along the 
internal elastic lamina and the surface of the 
plaque.

Results 

Collagen fibers were maximally separated from 
the background tissue

As shown in Figure 3, the images of atheroscle-
rotic lesions from both rabbits and mice were 
separated into their red, blue and green com-
ponents. However, if Methyl Blue was employed 
to stain collagen, the image was split into only 
its red and blue components (Figure 3). In the 
blue component, blue staining of the nucleus 
made it difficult to quantify the collagen fibers. 
However, when light green was used to identify 
collagen fibers, a green image was obtained, 
and the collagen fibers were shown with maxi-
mal separation from the background tissue in 
the green component (Figure 3).

Collagen fibers were conveniently quantified by 
ImageJ

In the green image, the collagen fibers could be 
quantified from the interested area (Figure 4). 
When a constant threshold was set, the colla-
gen fibers in different sections could be accu-
rately and consistently quantified by ImageJ 
(Figure 4). To compare with staining separation 
into three channels, image with deconvolution-
indeed made the collagen fibers to obtain maxi-

Figure 5. Comparison of the image processing by RGB image splitting and color deconvolution. The split channels 
function separated the RGB image into red, blue and green channels (upper). The deconvolution plugin separated 
the RGB image into a red component, blue component and green component (lower). 
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mal separation from the background tissue 
(Figure 5).

Discussion 

In this study, we present a method to estimate 
the area and integrated density of collagen 
fibers in an atherosclerotic lesion; this method 
is based on image analysis of a sample stained 
with Masson’s trichrome. As previously report-
ed, a wide range of collagen types are present 
in an atherosclerotic lesion, which increases 
the difficulty in quantifying collagens via immu-
nohistochemical staining [12, 13]. Thus, stain-
ing against various collagens within a lesion 
may help researchers to better quantify the col-
lagen density, and Masson’s trichrome stain is 
a potential option. 

For more than eighty years, Masson’s trichrome 
stain has been frequently used to stain colla-
gens in various tissues with either blue or 
green, depending on the dyes available (aniline 
blue or light green) [14]. However, because the 
three main colors often co-localize to the same 
area, it is difficult to analyze or quantify tissues 
stained with Masson’s trichrome stain [15]. In 
conventional digital imaging, bright field imag-
es are a composite of three 8-bit monochro-
matic channels (red, green, and blue) that form 
a 24-bit color image [16]. Based on this conven-
tion, the RGB images can be split into three 
channels (red, green, and blue), and using one 
of these three channels can result in selective 
contrast between common stains. Using this 
separation technique, on a monochromatic 
image allows maximal separation between pos-
itive-stained pixels and background tissue, 
which facilitates accurate calculations of both 
the area and intensity of immunohistochemical 
staining [17]. However, staining separation is 
not suitable for analysis of Masson’s trichrome 
stain because this technique has inefficient 
separation of the collagen fibers from the blue 
or green staining of other tissues. As previously 
reported, this incomplete separation was 
ascribed to the color spectrum of the available 
stains, with the common colors partially spread 
over all three channels [7]. To overcome this 
problem, Ruifrok et al. developed a plugin 
named “color deconvolution”, which separates 
a three-channel image into three colors [18]. 
Although some limitations should be consid-
ered in further applications, this technique can 
effectively separate the contributions of two 
co-localized stains [19]. 

As above description, a green image was 
obtained after image deconvolution, showing 
that collagen fibers were shown with maximal 
separation from the background tissue.

Moreover, monochrome imaging also helps 
researchers use this image for calculating the 
area and integrated intensity. Therefore, these 
techniques offer the feasibility of automatically 
extracting collagen fiber data from atheroscle-
rotic lesion images, which radically improve the 
methodology of collagen analysis based on 
Masson’s trichrome stain. This method is more 
objective, sensitive and accurate compared to 
the traditional Masson’s trichrome staining 
method. 

In conclusion, we presented a convenient me- 
thod to assess collagen fibers in atherosclerot-
ic lesions using Masson’s trichrome stain. This 
method was based on the cross-platform soft-
ware ImageJ and its associated color deconvo-
lution plugin. Because of the simplicity and 
accuracy of this method, it may be widely 
applied for studying atherosclerosis in human 
or various animal models.
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